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Shape-Out is a user interface for data analysis in real-time deformability cytometry (RT-DC). This is the documentation
of Shape-Out version 1.0.10.post2.

Please consider migrating your analysis pipeline to Shape-Out 2. The differences between Shape-Out 1 and
Shape-Out 2 are discussed in the Shape-Out 2 docs.

This documentation is also available as a PDF.

Contents 1
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CHAPTER 1

Getting started

1.1 Installation

Shape-Out can be installed via multiple channels.

1. Windows installer: Download the latest version for your architecture (e.g. ShapeOut_X.Y.
Z_win_64bit_setup.exe for 64bit Windows) from the official release page.

2. Python 2.7 with pip: Shape-Out can easily be installed with pip:

pip install shapeout[GUI]

Note that ShapeOut requires wxPython 3 and chaco. You might have to manually install these for your system
if they cannot be installed automatically via pip. To start Shape-Out, simply run python -m shapeout in a
command shell.

1.2 Update

Shape-Out automatically searches for updates (you may opt-out via the preferences menu) and notifies the user when
a new version is available.

1. Windows installer: The older version of Shape-Out will be automatically uninstalled when installing a new
version.

2. Python 2.7 and pip:

pip uninstall shapeout
pip install shapeout[GUI]

3
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CHAPTER 2

RT-DC Basics

This section conveys the basic understanding necessary for analyzing and interpreting RT-DC data. If you have the
feeling that something is not covered here, please create an issue on GitHub.

2.1 Working Principle

In Real-time deformability cytometry (RT-DC), small objects, such as cells or beads, are flushed through a narrow
channel at high speeds. The flow profile inside the channel causes hydrodynamic stresses that deform these objects
[MOG+15], [MMM+17]. For each event (detected object), an image is recorded and analyzed in real-time [ORM+15].
The analysis consists of the extraction of several features from the event images, such as deformation, projected area,
or average brightness. These features can then be used to identify and characterize sample populations; For instance,
major blood cells and their pathological changes in disease conditions [THO+17].

2.2 Measured Features

A multitude of features can be extracted from the data recorded during an RT-DC measurement. These features are
mostly computed live during data acquisition and are stored alongside the raw image data. Here, only the most impor-
tant features are discussed. A full list of the features available in Shape-Out is maintained in the dclab documentation.
Please note that some of the features are only available in expert mode.

2.2.1 Area and porosity

The area is the projected object area which is determined via the contour of the binarized event image. Shape-Out
differentiates between two types of area, area of the measured contour (“Measured area [px]”) and area of the convex
contour (“Convex area [px]” and “Area [µm2]”). The convex contour is the convex hull of the measured contour and
enables a quantification of porosity (convex to measured area ratio). The porosity is often used for filtering, e.g. to
remove high-porosity dirt particles in a preprocessing step.

1 Detection Of Human Disease Conditions By Single-Cell Morpho-Rheological Phenotyping Of Whole Blood by Toepfner et al., licensed under
CC BY 4.0 [THO+17].

5
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Fig. 1: Single-cell, morpho-rheological phenotyping of blood. (A) Analysis of whole, diluted blood. Hydrodynamic
shear forces (red arrows) induce deformation of cells passing through a microfluidic channel (20x20 µm2) at speeds of
more than 30 cm/s (blue arrows). (B) Representative images of blood cell types acquired. Scale bar is 10 µm. Figure
and caption adapted from Toepfner et al.1.

Fig. 2: Visualization of porosity. (A) The measured contour (blue line) defines the measured area (blue shade). The
convex contour (red line) results in an area (red shade) that is usually larger than the measured area. (B) The porosity
is the ratio between measured and convex contour. The difference (the “pores”) between the measured and convex
areas is indicated in green. Porosity is often used to remove events with non-physical contours, e.g. for cells all events
with a porosity above 1.05.

6 Chapter 2. RT-DC Basics
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A porosity of 1 means that the measured contour is convex. Note that the porosity can only assume values larger than
1. Also note that the convex contour/area is computed on the same pixel grid as the measured contour/area and is, as
such, subject to pixelation artifacts.

2.2.2 Bounding box

The bounding box of an event image is the smallest rectangle (with its sides parallel to the x and y axes) that can hold
the event contour. The aspect ratio of the bounding box is the rectangle’s side length along x divided by the side length
along y. The size of the bounding box along x and y as well as its aspect ratio are often used for filtering.

Fig. 3: Illustration of the event bounding box and its use cases. From left to right: definition of the bounding box,
exclusion of small objects (e.g. debris) via the bounding box size, exclusion of clusters via the bounding box size,
exclusion of objects elongated perpendicular to the channel axis, exclusion of objects elongated along the channel
axis.

2.2.3 Brightness within contour

Quantifying the brightness values within the image contour yields information on object properties such as homogene-
ity or density. For instance, it has been shown that the quantities “mean brightness” and “convex area” are sufficient
to identify (and count) all major blood cells in a drop of blood [THO+17].

In addition to the average brightness values, Shape-Out also has access to the standard deviation of the brightness in
each image.

2.2.4 Deformation and elasticity

The deformation describes how much an event image deviates from a circular shape. It is defined via the circularity:

deformation = 1− circularity

= 1− 2
√
𝜋𝐴/𝑙

with the projected area 𝐴 and the contour length of the convex hull of the event image 𝑙. The contour length is com-
puted from the convex hull to prevent an overestimation due to irregular, non-convex event shapes. It has been shown
that the knowledge of deformation and area allows to derive a value for elasticity in RT-DC [MOG+15] [MMM+17].
As a convenient measure for elasticity, isoelasticity lines are often employed to visualize stiffness.

Note that it is also possible to directly access the Young’s modulus in Shape-Out.

2.2. Measured Features 7
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Fig. 4: Blood-classification with event brightness and cell size. (A) Representative images of blood cell types acquired.
Scale bar is 10 µm. (B) Brightness versus cell size (area) scatter plot with cell types labeled according to the color
scheme in (A). Figure and caption adapted from Toepfner et al.1.

Fig. 5: (A) Typical deformation versus cell size scatter plot. The color scale indicates event density. (B) Isoelasticity
lines derived from numerical simulations indicate trends in stiffness.
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2.2.5 Fluorescence

Real-time fluorescence and deformability cytometry (RT-FDC) records, in addition to the event images, the fluores-
cence signal of each event [RPJ+18]. The raw fluorescence data consists of the one-dimensional fluorescence intensity
trace from which features such as peak fluorescence or peak width can be computed. For more advanced applications,
RT-FDC also supports multiple fluorescence channels.

Fig. 6: (A) Event brightfield image. (B) Fluorescence trace of the event. The raw fluorescence data and the fluores-
cence data filtered with a rolling median filter (from which the parameters are computed) is shown. (C) Scatter plot of
two parameters extracted from the fluorescence trace.

2.2.6 Inertia ratio

The inertia ratio is the ratio of the second order central moments along x and y computed for the event contour. Thus,
the inertia ratio is a measure of deformation. In comparison to deformation, the inertia ratio has a low correlation to
porosity. Shape-Out also allows to compute the principal inertia ratio which is the maximal inertia ratio that can be
obtained by rotating the contour. Thus, the principal inertia ratio is rotation-invariant which makes it applicable to
reservoir measurements where e.g. cells are not aligned with the channel. To quantify the alignment of the measured
objects with the measurement channel, Shape-Out can additionally quantify the tilt of the contour relative to the
channel axis.

2.2.7 Volume

Shape-Out can compute the volume from the event contour under the assumption of rotational symmetry, i.e. it is
assumed that the projection of the cell volume onto the detector plane does not change when the cell is rotated, with
a rotational axis parallel to the flow direction. The computation of the volume is based on a full rotation of the upper
and the lower halves of the contour from which the average is then used [HWT02]. Volume has the advantage to be
less correlated to deformation when compared to the projected area and it is therefore a better measure of cell size in
the channel.

2.2. Measured Features 9
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Fig. 7: (A) For a rectangle that is aligned with the coordinate axes, the inertia ratio and the principal inertia ratio
are identical. (B) If the rectangle is rotated, the inertia ratio changes, but the principal inertia ratio does not. (C)
Comparison between deformation and inertia ratio when plotted against porosity for an exemplary RT-DC experiment.
Deformation exhibits a higher correlation to porisity.

Fig. 8: (A) Deformation versus area (red) and volume (cyan) for an exemplary RT-DC dataset. There is a correla-
tion between area and deformation, at least for small (<50µm2) areas. (B) Inertia ratio versus area and volume. A
correlation between inertia ratio and area is visible as well.

10 Chapter 2. RT-DC Basics



CHAPTER 3

User Interface

3.1 Basic usage

On start-up, you are presented with an empty interface. To load data, use the menu File → Find Measurements and
select a directory containing experimental data. The directory is searched recursively for .tdms and .rtdc files which
are then displayed in the measurement browser on the left. Here, you can select the measurements and plot them
by clicking Analyze at the bottom of the measurement browser. The configuration tabs at the top allow you to filter
the data and change the visualization in the plot area. Individual events in the plot area can be selected and are then
displayed in the event area (top right). It is possible to adjust the sizes of measurement browser, configuration tabs,
event area, and plotting area by dragging the borders in-between those elements. The File menu allows you to save
sessions. To export data and plots, use the Export Data/Image menus.

3.2 Menu Bar

• File:

11

_images/menu.png
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Fig. 1: Shape-Out user interface on start-up. The measurement browser on the left is empty. The configuration tabs
on the top show the plotting settings. A dummy measurement is shown in the plotting area.

Find Measurements: Load experimental data into the measurement browser. The selected directory is
searched recursively for .tdms and .rtdc files.

Add Measurement: Add experimental data to the measurement browser without replacing those currently
shown.

Clear Measurements: Remove all measurements, which are not selected in the measurement browser.

Save session: Save the status of the current analysis.

Load session: Load a saved session.

Quit: Exit Shape-Out.

• Export Data:

All event data (*.fcs): Export datasets as flow cytometry standard files (scalar features only).

All event data (*.tsv): Export datasets as tab-separated values (scalar features only).

All event data (*.rtdc): Export datasets as .rtdc files. (expert mode only).

Computed statistics (*.tsv): Export the dataset statistics as tab-separated values.

All event images (*.avi): Export the event images as a video file.

• Export Image:

Graphical plot (*.pdf): Export the plot area as a .pdf file.

Event image with contour (*.png): Export the current event image including the contour.

Event image without contour (*.png): Export the current event image without contour.

• Batch:
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Statistical summary: Assemble a statistical summary for multiple datasets on disk (similar to Export Data →
Computed statistics (*.tsv), but for datasets that are not loaded in the current analysis). See the statistical
summary quick guide for more information.

• Preferences:

Autosave session: Automatically save the current session every five seconds. When Shape-Out unexpectedly
quits, the user is asked on start-up whether to load the autosaved session.

Check for updates: Automatically check for a new release and notify the user via the menu bar when a new
release is available.

Expert mode: Unlock experimental features. (see expert mode).

3.3 Measurement browser

The measurement browser shows the measurements that are available for plotting. They are sorted according to the
directory tree structure. For each measurement, the measurement index, the measurement region, the flow rate, and
the number of events are shown. The buttons at the bottom of the measurement browser allow to change the selection
(all, none, only specific flow rates).

The Analyze button loads the experimental data which is then visualized in the plot area. When a measurement is part
of the current analysis, it is shown with a bold font weight in the measurement browser.
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3.4 Plot Area

The plot area visualizes the current analysis. It is configured via the configuration tabs Plotting, Scatter Plot, and
Contour Plot (see below).

The axes limits can directly be modified with the mouse by dragging the plot with the left mouse button (axes offset),
zooming in or out with the mouse wheel, or by drawing a rectangle using the right mouse button (zoom to selection).

In addition, an individual event can be selected in a scatter plot, which is then displayed in the event area (top right).

3.5 Event Area

The event area shows information about individual events. At the top, the measurement and the event index can be
selected. The event image with the event contour (red) is shown. With the checkbox, individual events can be excluded
from an analysis.

The plot below (not visible initially - drag the border between event area and plot area or scroll down to make it visible)
shows the fluorescence signal over time. This plot is only available for RT-FDC data.
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3.6 Configuration Tabs

The configuration tabs allow to view and edit multiple aspects of the current analysis and facilitate additional analysis
steps.

3.6.1 Information

All properties of the current analysis are shown. If properties differ between measurements within an analysis, the
corresponding values are set to (multiple). To see the full panel, use the scroll bars or increase the size of the panel by
dragging the edge.

A summary of all valid metadata properties can be found in the dclab documentation. The most important properties
are:

event count: Number of recorded cells. In Shape-In this number is shown on the front panel as Number of cells
measured.

channel width: Dimension of the channel. This number is not detected automatically by Shape-In, but has to be set
by hand in the front panel under Channel dimension [µm].

chip region: The position of the region of interest during the measurement. This is not detected automatically by
Shape-In, but has to be set by hand in the front panel under Region of interest in the . . . .

flow rate: The sum of sheath and sample flow in µl/s. Shape-In records this number when the measurement starts and
shows it on the front panel under Flow Rate [µl/s].

frame rate: Camera frame rate during the measurement. Shape-In records this information when the measurement
starts and shows it in the expert tab under Camera tools and Framerate [Hz].

pixel size: Resolution of the microscope-camera-system in [µm/pixels]. In Shape-In this number is shown in the
expert tab settings under Resolution [µm/pix].

run index: The number of the measurement within the opened project. In Shape-In this number is shown on the front
panel under current/next #.

3.6.2 Calculate

This tab allows to compute additional features for the analysis.

Elastic modulus: Compute the elastic modulus according to [MMM+17]. The new feature Young’s Modulus [kPa]
(emodulus) will be available for plotting and analysis.

Fluorescence maximum crosstalk correction: Perform a crosstalk correction for multi-color RT-FDC measure-
ments. New features FL-1 maximum, crosstalk-corrected [a.u.] (fl1_max_ctc) will be available for plotting
and analysis.

3.6. Configuration Tabs 15

_images/config_tabs.png
https://dclab.readthedocs.io/en/stable/sec_av_notation.html#sec-experiment-meta


Shape-Out Documentation, Release 1.0.10.post2

3.6.3 Filter

In this tab, you can filter your data by excluding values beyond certain limits. Select the enable filters check box on
the right and hit the Apply/Reset button to apply/reset the settings. The Box Filters limit the range of parameters; the
Polygon Filters allow freely defining a gate by a polygon in the current plot. The filters are applied to all measurements
of the analysis, independent of the plot shown currently. For a quick guide to exclude invalid events, see Excluding
invalid events.

• Box Filters:

Box filters allow to set minium and maximum values for each feature (e.g. Area [µm]) of a measurement.
Minimum and maximum values for box filters are set to 0.0 by default. As long as they are equal, the filter is not
applied. On the left of the table the minimum value is set, on the right the maximum. For a list containing short
descriptions of all features, please see the dclab documentation. The most important box feature filters are:

Range area_ratio: Limit the porosity, the relative difference between convex hull area and cell area. A value
of “1”, means that the convex hull and is equal to event contour. Values smaller than “1” are not possible,
because the convex hull cannot be smaller than the contour.

Range area_um: Limit the cell area in [µm2].

Range aspect: Limits the aspect ratio of the bounding box, the ratio of height and length of the bounding box
around the contour of the event.

Range deform: Limits the deformation.

Range post x: Limit the position along channel axis [µm].

Range post y: Limit the position lateral in channel [µm].

Range time: Limits the event time [s].

Range x-size: Limit the bounding box size along the channel axis [µm].

Range x-size: Limit the bounding box size perpendicular to the channel axis [µm].

• Polygon Filters:

Polygon filters are two-dimensional filters that can be used to specify non-rectangular regions of interest. To
create a polygon filter, select the desired measurement (used as a plot template) in the dropdown menu and click
New. A new window pops up. Clicking on the plot will generate the points of the polygon filter. When you
are done, press Enter on the keyboard and close the window. The new polygon filter is then shown in the
list. Polygon filters can be applied to all measurements or only to individual measurements. You can see which
polygon filters are set for which measurement by selecting each measurement in the dropdown list. In addition,
polygon filters can be duplicated, inverted, exported and imported.

• Filter Hierarchy:

Filter hierarchies allow to create a virtual measurement from an existing measurement. All events that are
filtered in the original measurement will not show up in its hierarchy child, allowing to perform additional filter
operations on hierarchy children. This comes in handy e.g. when different subpopulations in a study need to be
distinguished without the noise (e.g. debris) in the original data. Children in hierarchies always update their data
according to the filtered event data from their parent, i.e. when the filters of the parent measurement change, the
hierarchy child changes as well.

3.6.4 Statistics

Show statistics of the current analysis. Please note that more comprehensive functionalities are available via the menus
Export Data → Computed statistics (*.tsv) and Batch → Statistical summary.
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3.6.5 Analyze

Regression analysis: Perform a regression analysis according to (general) linear mixed effects models. For more
information, please see Comparing datasets with LMM as well as the references [HKP+17] and [HMMO18]. If
you are using this feature in a scientific publication, please consider citing [HMMO18].

3.6.6 Plotting tabs

Plotting: Change the plotted axes and modify the displayed axis ranges. In addition, several plotting parameters can
be modified, including the number of plots, the types of plots shown and the types of isoelasticity lines shown.

Scatter plot: Modify the parameters of the scatter plots.

Contour plot: Enable or disable contour plots, modify contour plot parameters, and select the title and color for each
scatter plot.

New in version 0.9.2: Contour lines can now be plotted at KDE data quantiles (percentiles/100) instead of at
fractions of the overall KDE using the contour level mode option. A contour line at a 0.95 quantile contains 5%
of all data points.

3.7 Expert Mode

The expert mode is available via the menu Preferences → Expert mode. The following options are enabled in expert
mode:

• Export data in the .rtdc file format. Using .rtdc files instead of .tdms files speeds up the analysis in Shape-Out
significantly. However, exporting .tdms files to .rtdc files might be accompanied by data loss (most likely some
metadata keys are not converted and included in the resulting .rtdc files). Make sure to keep the original .tdms
datasets. You might have to re-generate the .rtdc files to be compatible with future versions of Shape-Out.

• Several features are made available for data analysis:

– Convex area [px] (area_cvx)

– Measured area [px] (area_msd)

– Video frame number (frame)

– Principal inertia ratio of raw contour (inert_ratio_prnc)

– Absolute tilt of raw contour (tilt)

See the dclab documentation for a full list of available features.
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CHAPTER 4

Quick Guides

4.1 Checking experimental data for consistency

• Trends over time:

To verify that the sample “behaves” stationary during the measurement, it is helpful to plot a few selected
features versus time. No systematic deviations should be observable, as in the figure below.

Fig. 1: Deformation and event area versus time. There is no systematic trend over time, indicating stable measurement
conditions.

• Countrate:

Trends over time do not directly visualize the count rate (measured events per second). The count rate is the
slope of the event index versus event time plot and should remain constant.
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Fig. 2: The event index versus event time plot shows a constant slope, an indicator for stable measurement conditions.

4.2 Excluding invalid events

Filters can be used to exclude invalid events, such as cell debris, cell doublets or larger aggregates, or cells that are not
intact, from an analysis.

• Area:

The event area (the area defined by the event contour) can be used to filter cell aggregates (larger area), dead or
degenerate cells, as well as cell debris (small area). Use the deformation versus area plot to identify exclusion
candidates by clicking on an event and visualizing it in the event area.

Fig. 3: Examples of events with small or large areas.

• Aspect and inertia ratio:

The aspect ratio of the bounding box and the inertia ratio of the contour can be used to filter cell aggregates and
otherwise invalid events. For instance, an aspect ratio below 1 (elongation perpendicular to the channel axis) is
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most-likely debris and can be excluded from the analysis. An inertia ratio below 1 also indicates invalid events.

Fig. 4: Examples of events with various aspect and inertia ratios.

• Porosity:

The porosity is the ratio between measured contour and the convex contour. Porosity is commonly used to
remove events with non-physical contours, e.g. for cells, all events with a porosity above 1.05.

Fig. 5: Examples of events with various porosities.

4.3 Young’s Modulus

With Shape-Out, it is possible to convert deformation values to values of the Young’s modulus based on numerical
simulation for fully elastic spheres according to Mokbel et al. [MMM+17].
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The “Calculate” tab allows you to obtain the Young’s modulus for the samples in the current analysis. After choosing
the type of measurement medium you must set the right temperature or – in case you choose “Other” – the correct
viscosity. For CellCarrier media, the correct viscosity is automatically calculated, taking shear-thinning into account
as discussed in [Her17].

Once “Compute elastic modulus” is clicked, the Young’s modulus will become available for plotting and data analysis.

Validity:

The computation of the Young’s modulus is valid only for objects that initially have a spherical shape. In addition,
the deformation and size values must be in a “valid region”. Events outside this region will have a nan-valued (not
a number) Young’s modulus. Note that as a result, these events will be excluded from all plots when remove invalid
events is checked in the Filter configuration tab.

The invalid regions (white in the figure above) include objects that are very small or objects with very low deformation
values. The reason for that is a very steep increase of the Young’s modulus with little decrease in deformation that
could potentially result in very large simulation errors. In addition, regions with high deformation are invalid as
well, because the simulations do not converge (objects simulated with lower Young’s moduli become more and more
elongated until they rupture). In practice, this means that the channel size has to be selected carefully to match the
object sizes. Larger object sizes require wider channels if meaningful values for the Young’s modulus are to be
computed.

In the following, additional visualizations for commonly used channel sizes and flow rates are shown:
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Fig. 6: Visualizations of the support and the values of the look-up table (LUT) used for determining the Young’s
modulus from deformation and cell area. The values of the Young’s moduli in the regions shown depend on the
channel size, the flow rate, the temperature, and the viscosity of the medium [MOG+15]. Here, they are computed for
a 15 µm wide channel at 24°C with an effective pixel size of 0.34 µm. The data are corrected for pixelation effects
according to [Her17].
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4.4 Batch-mode statistical summary

The Statistical information of the current analysis is displayed in the Statistics configuration tab and can also be
exported via the Export Data menu.

With the statistical summary tool (accessible via the menu Batch → Statistical summary), you may compute the
statistics for multiple measurements on disk, without loading them into an analysis session in Shape-Out:

1. Select the filter settings to use. At the time of this writing, only the filter settings of a measurement in the current
session can be used.

2. Click Browse to select an input folder that contains RT-DC measurement data. This folder will be recursively
searched for measurements (*.tdms and *.rtdc files). The number of measurements found is then shown in the
dropdown box below.

3. If applicable, select the flow rate and the chip region for which you need the statistics summary.

4. Select the features for which to compute the statistics and the statistical parameters to extract.

5. Click Browse at the bottom to select the output file and click on Assemble statistical summary to start the
computation.

Note that depending on the number of measurements and on the data type (*.rtdc data is loaded faster than *.tdms
data), the computation may take some time.
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4.5 Comparing datasets with LMM

It is not straightforward to define a p-Value for RT-DC data (e.g. change in deformation for a treatment vs. its control).
This is somewhat counter-intuitive, because one could assume that the large number of events in a single dataset should
be enough to compare two datasets. Focus changes, chip-to-chip variations, etc. may generate systematic offsets which
make a direct comparison (e.g. t-Test) impossible. Linear mixed models (LMM) allow to assign a significance to a
treatment (fixed effect) while considering the systematic bias in-between the measurement repetitions (random effect).

Shape-Out offers a LMM analysis as described in [HMMO18]. The LMM analysis is performed using the lme4 R
package. Here, we make use of the dataset [XRM+20] to illustrate this functionality.

4.5.1 Basic linear mixed models

We would like to quantify the difference between human skeletal stem cells (SSC) and the human osteosarcoma cell
line MG-63 (which is often used as a model system for SSCs) using a likelihood ratio test based on LMM.

From the dataset [XRM+20], load the following files into Shape-Out:

• SSC_16uls_rep1_20150611.rtdc (SSC repetition 1)

• SSC_16uls_rep2_20150611.rtdc (SSC repetition 2)

• MG63_pure_16uls_rep1_20150421.rtdc (MG-63 repetition 1)

• MG63_pure_16uls_rep2_20150422.rtdc (MG-63 repetition 2)

• MG63_pure_16uls_rep3_20150422.rtdc (MG-63 repetition 3)

In this example, we treat SSC as our “treatment” and MG-63 as our “control”. These are just names that remind us
that we are comparing one type of sample against another type.

In the Filter tab, please choose the following Box filters:

• Porosity (area_ratio): 0 to 1.05

• Area [µm2] (area_um): 120 to 550

• Deformation (deform): 0 to 0.1

Hit Apply and proceed to the Calculate tab. We would also like to have a look at the Young’s modulus. The medium
(CellCarrier) and the temperature (23°C) should already be set. Hit Compute elastic modulus to make the Young’s
modulus available.
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Proceed to the Analyze tab. Set the Interpretation and Repetition according to the following scheme (see screenshot):

• SSC: Treatment

• MG63: Control

• Repetition according to the file/sample name

Make sure that the feature “Deformation” is selected and hit Apply. The results of the LMM analysis are shown in
your default text editor:

LINEAR MIXED MODEL:
Linear mixed model fit by REML ['lmerMod']
Formula: xs ~ treatment + (1 + treatment | timeunit)

Data: RTDC

REML criterion at convergence: -34724.9

Scaled residuals:
Min 1Q Median 3Q Max

-2.0760 -0.7148 -0.1546 0.5299 5.3384

Random effects:
Groups Name Variance Std.Dev. Corr
timeunit (Intercept) 0.000e+00 0.000e+00

treatmentTreatment 5.438e-23 7.374e-12 NaN
Residual 1.592e-04 1.262e-02

Number of obs: 5883, groups: timeunit, 3

Fixed effects:
Estimate Std. Error t value

(Intercept) 0.0319279 0.0002052 155.58
treatmentTreatment -0.0013548 0.0003433 -3.95

(continues on next page)
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(continued from previous page)

Correlation of Fixed Effects:
(Intr)

trtmntTrtmn -0.598

COEFFICIENT TABLE:
(Intercept) treatmentTreatment

1 0.03192788 -0.001354766
2 0.03192788 -0.001354766
3 0.03192788 -0.001354766

LIKELIHOOD RATIO TEST (MODEL VS. NULLMODEL):
Data: RTDC
Models:
NullModel: xs ~ (1 + treatment | timeunit)
Model: xs ~ treatment + (1 + treatment | timeunit)

Df AIC BIC logLik deviance Chisq Chi Df Pr(>Chisq)
NullModel 5 -34738 -34705 17374 -34748
Model 6 -34743 -34703 17377 -34755 6.2303 1 0.01256 *
---
Signif. codes: 0 ‘***’ 0.001 ‘**’ 0.01 ‘*’ 0.05 ‘.’ 0.1 ‘ ’ 1

The most important numbers are:

• Fixed effects (Intercept)-Estimate: The mean of the parameter chosen for all controls.

• Fixed effects treatment-Estimate: The effect size of the parameter chosen between the mean of all controls
and the mean of all treatments.

• Full coefficient table: Shows the effect size of the parameter chosen between control and treatment for every
single experiment.

• Model-Pr(>Chisq): Shows the p-value and the significance of the test.

We are interested in the p-value, which is 0.01256 for Deformation. We repeat the analysis with Area (0.0002183)
and Young’s modulus (0.0002771). The p-values indicate that MG-63 (mean elastic modulus 1.26 kPa) cells are softer
than SSCs (mean elastic modulus 1.54 kPa) [HMMO18].

Important: Why are the p-values different when I swap repetitions in LMM analysis?

(A comment by Maik Herbig)

If this happens, you essentially changed the pairing of measurements. In Shape-Out you can determine the “Repetition
number” of your experiment. If the same repetition number is chosen for a “Control” and a “Treatment” measurement,
a paired test will be conducted. In your experimental design you determine which measurements are paired, before
doing any experiments. Do not start to pair experiments after you have seen the data to obtain the lowest p-value
(this would be p-hacking). For example you could decide to measure one “control” and one “treated” sample on three
consecutive days. Then, it makes sense to pair the measurements of the same day. Oftentimes this is not possible and
you have to measure 3x “control” on one day and 3x “treated” on the next day. Then you could for example pair the
first measurement of “control” with the first measurement of “treated” and the second of “control” with the second of
“treated” and so on.

Alternatively, you can also run an an unpaired test by just giving each measurement a different “Repetition” number.
For example when having 3x “control” and 3x “treatment” you could give it numbers from 1 to 6.
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4.5.2 LMM analysis of differential deformation

The LMM analysis is only applicable if the feature chosen is not pronounced visibly in the reservoir measurements.
For instance, if a treatment results in non-spherical cells in the reservoir, then the deformation recorded for the treat-
ment might be biased towards higher values. In this case, the information of the reservoir measurement has to be
included by means of differential deformation [HMMO18]. The idea of differential deformation is to subtract the
reservoir from the channel deformation. Since it is not possible to assign the events in the reservoir to the events in
the channel (two different measurements), bootstrapping is employed which generates statistical representations of
the two measurements that can then be subtracted from one another. Then, for the actual LMM analysis, only the
differential deformation is used.

For differential deformation analysis, we need for each repetition a reservoir measurement (e.g. Treatment 1 and
Reservoir Treatment 1). From the dataset [XRM+20], load the following files into Shape-Out and proceed with
filtering as described above:

• SSC_16uls_rep1_20150611.rtdc (SSC repetition 1)

• SSC_16uls_rep2_20150611.rtdc (SSC repetition 2)

• SSC_reservoir_rep1_20150611.rtdc (SSC reservoir repetition 1)

• SSC_reservoir_rep2_20150611.rtdc (SSC reservoir repetition 2)

• MG63_pure_16uls_rep1_20150421.rtdc (MG-63 repetition 1)

• MG63_pure_16uls_rep2_20150422.rtdc (MG-63 repetition 2)

• MG63_pure_16uls_rep3_20150422.rtdc (MG-63 repetition 3)

• MG63_pure_reservoir_rep1_20150421.rtdc (MG-63 reservoir repetition 1)

• MG63_pure_reservoir_rep2_20150422.rtdc (MG-63 reservoir repetition 2)

• MG63_pure_reservoir_rep3_20150422.rtdc (MG-63 reservoir repetition 3)
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In the Analyze tab, there are now ten measurements to assign. Proceed as above, using the sample names as indicator
for treatment/control and repetition (see screenshot).

Note: The data sets are ordered according to run index. In an ideal case, the run index would resemble the repetition
of an experiment. Here, however, the run index is only an internal lab book reference.

The results read as follows:

LINEAR MIXED MODEL ON BOOTSTAP-DISTRIBUTIONS:
Linear mixed model fit by REML ['lmerMod']
Formula: xs ~ treatment + (1 + treatment | timeunit)

Data: RTDC

REML criterion at convergence: -59591.1
(continues on next page)
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(continued from previous page)

Scaled residuals:
Min 1Q Median 3Q Max

-6.5206 -0.5391 0.0077 0.5700 6.3890

Random effects:
Groups Name Variance Std.Dev. Corr
timeunit (Intercept) 2.939e-07 0.0005421

treatmentTreatment 1.273e-06 0.0011284 -1.00
Residual 3.862e-07 0.0006215

Number of obs: 5000, groups: timeunit, 3

Fixed effects:
Estimate Std. Error t value

(Intercept) 0.0205095 0.0003132 65.49
treatmentTreatment -0.0052991 0.0006518 -8.13

Correlation of Fixed Effects:
(Intr)

trtmntTrtmn -1.000

COEFFICIENT TABLE:
(Intercept) treatmentTreatment

1 0.01993562 -0.004104567
2 0.02058056 -0.005447047
3 0.02101226 -0.006345642

LIKELIHOOD RATIO TEST (MODEL VS. NULLMODEL):
Data: RTDC
Models:
NullModel: xs ~ (1 + treatment | timeunit)
Model: xs ~ treatment + (1 + treatment | timeunit)

Df AIC BIC logLik deviance Chisq Chi Df Pr(>Chisq)
NullModel 5 -59605 -59572 29807 -59615
Model 6 -59613 -59574 29813 -59625 10.584 1 0.001141 **
---
Signif. codes: 0 ‘***’ 0.001 ‘**’ 0.01 ‘*’ 0.05 ‘.’ 0.1 ‘ ’ 1

The p-value for the differential deformation is 0.001141 which is a magnitude lower than the p-value for the (non-
differential) deformation above. This indicates that there is a non-negligible initial deformation of the cells in the
reservoir.

Attention: Differential LMM analysis does not make sense for all features. For instance, differential area will
yield high values, because the measured area in the reservoir and the sample are similar. Thus, the LMM analysis
is performed with distributions that are all centered around zero, yielding no significant difference.

4.5.3 Generalized linear mixed models (GLMM)

Shape-Out also makes available one GLLM. The implementation uses the function glmer (instead of lmer for
LMM) from the lme4 R package. It employs an additional log-link function using the family keyword argument
(family=Gamma(link='log')). The Gamma function is used generally for data that are continuous and non-
negative. The log-link function is useful if the feature distribution is log-normal. The log-link function exponentiates
the linear predictors of the LMM (It does not log-transform the outcome variable).
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Log-normal behaviour is a quite common, especially in biology. When a physical parameter has a lower limit, and the
measured values are close to that limit, the resulting distribution will be skewed, resembling a log-normal distribution.
In case of RT-DC this is specially (but not only) true for deformation. Another example is area, which also has a lower
limit of zero and may therefore have a skewed distribution. While GLMMs are designed to handle skewed data, it was
shown that LMMs already deliver robust results, even for highly skewed data [GH06].

Warning: As we learned above, the decision whether to use LMM or GLMM is not particularly important.
Ideally, both LMM and GLMM are consistent. However, never perform both analyses only to then pick the one
with the lowest p-value. This is p-hacking! The analysis routine should be defined beforehand. If in doubt, stick
to LMM.
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CHAPTER 5

Changelog

List of changes in-between Shape-Out releases.

5.1 version 1.0.11

• setup: bump dclab from 0.25.0 to 0.26.0 (volume-deformation isoelasticity lines)

5.2 version 1.0.10

• ci: Windows build not working since version 1.0.7, because of incompatible numpy versions during dclab build

5.3 version 1.0.9

• fix: do not trust the “index” feature of a dataset to contain a correctly enumerated index (dclab<0.25.0 might
have generated false values when joining datasets)

• setup: bump dclab from 0.24.8 to 0.25.0

5.4 version 1.0.8

• setup: bump dclab from 0.24.0 to 0.24.8 (faster polygon filtering)

5.5 version 1.0.7

• setup: bump dclab from 0.22.5 to 0.24.0 (equidistant isoelasticity lines, slightly larger emodulus LUT)
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• setup: bump nptdms to 0.23.0

• docs: build failed (#269)

5.6 version 1.0.6

• fix: case-sensitivity issue when getting the chip region from an .rtdc file (#268)

5.7 version 1.0.5

• fix: use UTF-8 encoding by default when dealing with text files (#267)

5.8 version 1.0.4

• fix: minor issue with converting pos_y feature in sessions from before 0.7.6

• setup: bump dclab from 0.21.1 to 0.22.5 (improve contour retrieval for mask images with artefacts, disable
computation of Young’s modulus for reservoir measurements)

5.9 version 1.0.3

• fix: contour plot not possible (regression introduced in 1.0.1) (#265)

5.10 version 1.0.2

• setup: bump dclab from 0.20.1 to 0.21.1

5.11 version 1.0.1

• fix: MemoryError when plotting log-log data (#264)

5.12 version 1.0.0

• fix: change the way measurements are recognized (.rtdc files were falsely grouped together when located in the
same directory) (#262)

• fix: automatic update did not include link to executable

• docs: rewrite section for LMM analysis

5.13 version 0.9.8

• fix: regression in polygon filter creation (event images not shown on hover) (#260)
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5.14 version 0.9.7

• fix: batch statistical analysis used one measurement per folder (#252)

• fix: redrawing-issues of control panels (#253)

• docs: minor update

• setup: bump dclab from 0.14.7 to 0.18.0

5.15 version 0.9.6

• enh: improved support for tdms data (dclab 0.12.0 -> 0.14.7) (e.g. #249)

• enh: write Shape-Out version to exported .fcs and .tsv files (#250)

• fix: remove nan/inf values before performing (g)lmm analysis (#248)

• docs: request citation of Herbig2018 when performing (g)lmm analysis

5.16 version 0.9.5

• fix: Allow to open measurement files that do not contain the features “area_um” or “deform” (#245)

• fix: Hide unused fluorescence trace line plots

• fix: Draw median trace data on top of raw trace data

• enh: Display session name in window title

• enh: Allow to hide raw fluorescence trace data

5.17 version 0.9.4

• fix: Wrong image/trace data shown for a selected event in the scatter plot when working on a log-scale (#244)

• enh: minor speed-up when working with hierarchy children and exporting the ‘contour’ feature (dclab 0.11.0)

5.18 version 0.9.3

• enh: Allow to select colormap (#239)

• fix: dclab 0.10.4 workaround for defective feature in Shape-In versions 2.0.6 and 2.0.7 (#241)

• setup: remove pinning of numpy (works again on Ubuntu 18.04)

5.19 version 0.9.2

• Allow to set contour levels at quantiles instead of KDE fractions (#180)

• Allow to manually select contour levels
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• Log-scale contour plots are now available (#231)

• Pin numpy version to <=1.13.0 to prevent ValueError caused by chaco testing whether an array object is con-
tained in another object

• Bugfixes:

– Log-scale scatter plots did not show log-scale KDE data (#231)

– Contour lines were shifted by a small amount due to an uncommon interpretation of contour plots in chaco
(contour lines are now computed by dclab using the marching squares algorithm implemented in skimage)

– Bad indexing in exported .rtdc datasets made it impossible to browse the video data (dclab 0.10.2)

5.20 version 0.9.1

• Add tooltips for box filter settings

• Rename Statistical analysis to Statistical summary in batch menu

• Add link to documentation in help menu

• Major documentation update

• Bugfixes:

– Remove temporary session-save directory when autosaving fails due to nonexisting analysis

– Several minor fixes in dclab 0.9.1

5.21 version 0.9.0

• Introduce new online documentation at http://shapeout.readthedocs.io

• Consistently use the term Shape-Out

• Code cleanup and compatibility with dclab 0.8.0

• Enhancements:

– Order input fields in measurement browser according to measurement number (#229)

– Support new features “temperature” and “ambient temperature” (dclab 0.9.0)

• Bugfixes:

– Displaying the contour of .rtdc files that do not contain the “mask” feature resulted in an error.

– ValueError in settings.py when stored data does not contain a key-value pair or when the value is missing.

– IndexError when clicking on an event that has no image data

– When the titles of all measurements are identical, the measurement selection in the combobox does not
have any effect on the displayed measurement when creating a new polygon filter.

– Possible errors when loading sessions containing empty datasets

38 Chapter 5. Changelog

https://github.com/ZELLMECHANIK-DRESDEN/ShapeOut/issues/231
https://github.com/ZELLMECHANIK-DRESDEN/ShapeOut/issues/231
http://shapeout.readthedocs.io
https://github.com/ZELLMECHANIK-DRESDEN/ShapeOut/issues/229


Shape-Out Documentation, Release 1.0.10.post2

5.22 version 0.8.8

• Bugfixes:

– “Mean of empty slice” error when attempting to plot bad data

• New ancillary features in expert mode:

– Principal inertia ratio (dclab 0.6.3.dev1)

– Absolute tilt of raw contour (dclab 0.6.3.dev2)

• Add computation of Young’s modulus for water medium (dclab 0.6.3.dev14)

• Show fluorescence metadata in Information tab

• Display data paths as tool tip in title editor (Contour Plot tab) (#227)

5.23 version 0.8.7

• Bugfixes:

– Search for missing datasets was falsely extended to directories not chosen by the user

– Add recording date/time tooltip in the analysis tab to avoid ambiguities (#223)

– Allow arbitrary number of repetitions for mixed model analysis with a spin control (#222)

– Setting the treatment to “None” for (g)lmm analysis did not exclude it from the analysis, but introduced it
as a different treatment (#224)

– Channel width not correctly identified for old tdms files (dclab 0.6.2.dev7)

– Do not draw isoelastics in contour plot if measurements have different channel widths

• Automatically identify treatment and repetition for mixed model analysis (#222)

• Automated release to PyPI with appveyor

• Begin migration of docs to sphinx/readthedocs.org

5.24 version 0.8.6

• Refactoring:

– Use pathlib instead of os.path for

* All session handling/conversion tasks

* Configuration file management

* Measurement/Analysis management

– Support all changes to dclab.definitions (dclab 0.4.0)

– Support all changes to dclab.features (dclab 0.5.0)

• Bugfixes:

– Opening sessions containing paths to data with a hash “#” failed

– AttributeError during autosave when no measurement data is available
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– Exporting to .fcs files failed due to NaN-valued events; Events containing NaN values are now ignored
(fcswrite 0.1.3.dev22) (#215)

– Improve displayed float values for selected configuration keys (#216)

– Unicode error when searching for data sets on disk (#218)

– Unicode error when performing LMM analysis on some setups (#217)

– IndexError when obtaining meta data from previous, broken analysis

– KeyError when starting a new analysis with unavailable plotting axes

– Ignore broken .rtdc data files

5.25 version 0.8.5

• Update plotting range when switching to log scale (#198)

• Allow to fix plotting range to retain previous behavior (#198)

• Initial plotting range is determined from min/max values of all plots (#213)

• Improved standard contour and kde accuracies using Doane’s formula (#147)

• Bugfixes:

– Support opening tdms files with capitalized “userDef” column names (dclab dclab 0.3.2.dev5) (#212)

– Wx colors and chaco not compatible anymore (Windows appveyor build)

• Refactoring:

– Use pathlib when saving and opening sessions and do not use os.chdir

5.26 version 0.8.4

• Add pixelation-corrected numerical and analytical isoelastics (#203)

• Update emodulus look-up table (dclab 0.3.1.dev3) (#202)

• Improved handling of polygon filters (partly #95)

• Updated R version to 3.2.5 due to build errors

• Bugfixes:

– Young’s modulus computation is wrong due to faulty FEM simulations (dclab 0.3.1.dev20) (#207)

– Image/trace panel shows wrong event when the mouse pointer hovers from one scatter plot to another

– Hierarchy children: image, contour, and trace data were not displayed in the image/trace panel (dclab
0.3.1.dev1) (#100)

– Hierarchy children did not support manual filters (dclab 0.3.1.dev2)

– Regression: Setting plotting range manually not possible (#201)

– Pixel size not read from tdms-based data (dclab 0.3.1.dev13) (#205)

– “limit events” filtering must be integer not boolean (dclab 0.3.2.dev3) (#210)
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5.27 version 0.8.3

• Prefer sample name from para.ini over data folder name (dclab 0.3.0.dev15)

• Support new .rtdc file format (dclab 0.3.0.dev20) (#151)

• Bugfixes:

– Automatically fix inverted plotting range

– Enable scrolling in data export dialogs

– Ignore missing features during data export

– Plotting circularity with isoelastics failed (dclab 0.3.0.dev21) (#197)

– Plotting errors with log-scale axes (#194, #195)

– SHIFT+ENTER shortcut did not update filters

– Fixed memory leak (#187)

5.28 version 0.8.2

• Add fluorescence crosstalk correction (#185)

• Bugfixes:

– Regression: Session autosaving broken (#191)

– Young’s modulus not updated (dclab 0.2.9.dev9) (#190)

– UnicodeDecodeError on fcs-export (fcswrite 0.1.3.dev15) (#189)

– Mouse cursor stuck in wait when plotting hierarchy data (#188)

• Code cleanup:

– Use the term “feature” consistently (dclab 0.2.9.dev2)

– Use file format agnostic fluorescence trace keys (dclab 0.2.9.dev4)

5.29 version 0.8.1

• Update internal configuration parameter names (dclab 0.2.8)

• Cache event counts of tdms-based data sets on disk (#179)

• Bugfixes:

– KeyError when isoelastics not defined for combination of axes (#177)

– Wrong channel width when loading ShapeIn 2.0.1 tdms data (dclab 0.2.9)

5.30 version 0.8.0

• Remember directory for searching missing measurement data

• Bugfixes:
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– Cannot open old session files with hierarchies when the measurement data location has changed (#174)

– Cannot open polygon filters exported versions < 0.7.6 (#174)

• Code cleanup:

– Move program-relevant data to “shapeout” directory

– Move computation of isoelastics to dclab (dclab 0.2.6.dev23)

– Create separate directory for appveyor recipe

– Remove unused/incomplete support for internationalization

5.31 version 0.7.9

• Add on-the-fly computation of contour inertia ratios

• Add menu options to save current event image (#164)

• Bugfixes:

– Isoelastics are not shown (#145)

5.32 version 0.7.8

• Introduce unique identifiers for measurements (dclab 0.2.5.dev4)

• Include ffmpeg in the Windows installer (#165)

• Bugfixes:

– dclab 0.2.6.dev2: Correctly identify contour files (#166, #169)

– dclab 0.2.5.dev11: Allow contour data indices larger than uint8 (#167)

• Refactoring:

– dclab 0.2.5.dev10: Event images are returned as 2D ndarray

5.33 version 0.7.7

• Add “Preferences” menu:

– Allow to (dis/en)able session autosaving

– Allow to (dis/en)able checking for updates

– Allow to (dis/en)able expert mode (#157)

• Bugfixes:

– Hidden axes (“area_cvx”, “area_msd”, “frame”) visible in analysis tab

– Display of fluorescence traces broken (#159)

– Display of contour plots broken (#160)

– Error when loading sessions created with version 0.7.6 on Windows

– dclab 0.2.5.dev1: Automatically fix ancillary column sizes
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– dclab 0.2.5.dev2: Correctly distinguish b/w hierarchy children of same parent

5.34 version 0.7.6

• Add on-the-fly computation of average and SD for brightness

• Bugfixes:

– Save sessions with deep (>1) hierarchies correctly

– Better backwards compatibility for old session files

• Refactoring (dclab 0.2.5):

– New standard column names

– New class for handling filtering

– Minor speed-up when dealing with hierarchies

5.35 version 0.7.5

• Move from OpenCV to imageio (#129)

• Allow to select region and flow rate in batch processing (#132)

• Allow to create an inverted copy of a polygon filter (#127)

• Define new configuration file path with appdirs

• Add on-the-fly computation of volume (dclab 0.2.3.dev23)

• Change: Disable “remove invalid events” in filtering to avoid computation of ancillary columns (performance)

5.36 version 0.7.4

• Add de-/select all buttons to Batch | Statistical analysis

• Add de-/select all buttons to export all events data (#148)

• Bugfixes:

– Young’s modulus not computed in batch analysis (#149)

– dclab 0.2.3.dev4: Loading old session files with polygon filters (#152)

– Sessions saved with Windows cannot be opened on Linux (#153)

– Regression: save button did not work

5.37 version 0.7.3

• Add interface to calculate elastic modulus

• Bugfixes:

– Regression analysis not working for some Windows regional settings (#142)
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– Filters not applied when loading a session

– Regression: Not possible to manually set plotting range

– Excluded events were plotted despite downsampling limit

– Support columns containing NaN and infinite values

• dclab 0.2.3:

– Add filtering option “remove invalid events” to remove nan/inf

– Add methods to compute elastic modulus

• fcswrite 0.1.3.dev6

– Range for fluorescence data is always 2**15

– Range for Deformation/Circularity is 100 or 1.0

5.38 version 0.7.2

• Set histogram-based kernel density estimator as default (#133)

• Regression analysis:

– Added generalized linear mixed effects model (#126)

– Remember treatment and repetition for each measurement (#134)

• Bugfixes:

– Same default location for find/add measurements dialogs (#139)

– Opening saved sessions with more than nine data sets failed (#141)

5.39 version 0.7.1

• Improved speed by optimization of GUI functions

• Hash checks: Replace exception with a user-friendly warning (#128)

• Change: Renamed config key “kde multivariate” to “kde accuracy”

• Bugfixes:

– Contour plot displays unused contour accuracy parameters

– Persistent busy cursor when trace or video data is missing

– Directory selections not always remembered correctly

• dclab:

– Add histogram-based kernel density estimator

– Refactoring to improve code quality
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5.40 version 0.7.0

• Allow to rename polygon filters (#119)

• dclab:

– Traces are loaded lazily (on demand)

– Add “Event index” column (#124)

5.41 version 0.6.9

• Disable kernel density estimation and contour plot by default (#116)

• Add avi export option

• Bugfixes:

– Fluorescence traces not shown for some data sets (#118)

– Prefer the R package that is shipped with the executable over a system installation (#120)

– Image plot and fluorescence traces were not always updated correctly

– Regression: Contour plot offset by one frame in some cases (#121)

• dclab:

– Add user defined data fields 0. . . 9

– Add principal components 1 and 2

– Change Cell size to Area

5.42 version 0.6.8

• Speed-ups:

– search for measurements (#113)

– dclab 0.1.9.dev10: contour handling

5.43 version 0.6.7

• Minimize memory usage for batch processing (#108)

• Allow export to flow cytometry standard file format (#54)

• dclab 0.1.9.dev2: add support for “User Defined” column in tdms files

• dclab 0.1.9.dev7: compute default parameters for contours (#55, #110)
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5.44 version 0.6.6

• Hide unimportant data in Info tab (#102)

• Disable/Enable controls dependent on values of other controls (#103)

• Bugfixes:

– Regression: Error when batch analysis started (#105, #106)

– Contour error when plot contains no events (#104)

5.45 version 0.6.5

• Sessions are now autosaved every 60s (#97)

• Bugfixes:

– Loading of sessions with hierarchy children failed (#99)

– Reduced a memory leak for new analyses that resulted in frequent memory errors (should be less frequent
now)

5.46 version 0.6.4

• Bugfixes:

– Batch analysis: Individual measurement parameters not preserved (#96)

– Legend plot: >9 measurements cannot be displayed in legend at the same time. Introduced new config key
“Legend Autoscaled” (#91)

• New filter hierarchy allows to investigate subpopulations (#87, #63)

• dclab

– Add InertiaRatio and InertiaRatioRaw to tdms files (typo)

5.47 version 0.6.3

• Bugfixes:

– Regression: Excluded events plotted on top of filtered events (#86)

– PDF plot export: Scatter inspector event highlighted (#92)

• Implement differential (w.r.t. reservoir) linear-mixed models analysis with bootstrapping (#88)

5.48 version 0.6.2

• Add batch filter processing

• Move statistics computation to dclab (0.1.7.dev12):

– New columns: “Flow rate”, “%-gated”
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• Bugfixes:

– Windows: Saving session on different drive than data causes ValueError

– Memory leak: Re-plotting scatter plots (ControlPanel.OnChangeFilter)

– Handle plots where all events are filtered correctly

– Scatter plots: False filtered events shown in gray

– dclab (0.1.7.dev9): Faulty hashing strategy in RTDC_DataSet.GetDownSampledScatter

– dclab:

* Corrections/additions in definitions (fRT-DC)

5.49 version 0.6.1

• Load session: Allow user to select missing data files (#80)

• Sessions: Store relative paths in index file for user convenience (#80)

• Bugfixes:

– Setting order of plots not possible in Windows (#79)

– Inability to search measurements due to broken data files (#81)

5.50 version 0.6.0

• Compute mode in statistics tab using Freedman-Diaconis rule (#72)

• Add channels: bounding box x- and y-size

• Display number of events in measurement browser (#70)

• Bugfixes:

– “KeyError: ‘Plotting’” when filtering (#73)

– “AttributeError” when plotting 2col 1row without legend (#76)

5.51 version 0.5.9

• dclab add channel: distance between two first peaks

• Allow logarithmic plot axes (#56)

• Display fluorescence curve of events (#65)

• Bugfixes:

– OpenCV version 2 vs 3 variable name differences (CV_CAP. . . )

– Gray dots in PDF export too large (#69)
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5.52 version 0.5.8

• dclab add fluorescence channels: peak area, peak position, number of peaks

• dclab add position along channel axis from img

• dclab (0.1.6.dev2): Allow to disable KDE computation

• Allow to change order of plots (#51)

• Implement indexing of events (#49)

• Allow to exclude single events (#47)

• Allow to show excluded events in scatter plot (#52)

• Display cell images in the polygon selection window (#64)

• Bugfixes:

– Settings panel not redrawn in Ubuntu (#66)

– Order of plots not reproduced from session (#51)

– OpenCV version 2 vs 3 changes (#45)

5.53 version 0.5.7

• Bugfixes:

– Filtering: Plot selection resets to last item unexpectedly

– User-defined titles were not saved in session

– Remove ghost images of cells (#18)

– dclab (0.1.5.dev13): Correct determination of video file

– dclab (0.1.5.dev14): Multivariate KDE did not work

– dclab (0.1.5.dev15): “Contour Fix Scale” did not work for Defo

5.54 version 0.5.6

• Add menu option for data export (#22)

• Add shortcut SHIFT+ENTER for “Apply” controls (#48)

• Bugfixes:

– Define “Video Frame Offset” parameter to correctly index frames (#46)

5.55 version 0.5.5

• Bugfixes:

– String formatter did not work (#40)

– Regression in dclab<0.1.5 (#43)
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5.56 version 0.5.4

• Changes in dclab:

– Support for 3-channel fluorescence data (add corrections 21:42)

– Fix behaviour with empty columns (#1 dclab)

5.57 version 0.5.3

• Fixes in dclab:

– Use correct lateral position (from channel walls) (#37)

– Compute aspect ratio according to elongation along flow (#38)

• Allow to change thickness of contour lines (#34)

• Display number of events in statistics tab (#35)

• Improve visual representation in statistics tab

5.58 version 0.5.2

• Bugfix: PDF export did not work (#33)

• Fix disappearance of scrollbars upon hitting apply in controls

5.59 version 0.5.1

• New logo (#25)

• Bugfix: Analysis tab reset button (#30)

• Display correct axis names in Plotting tab

• Fix appveyor build script with pinning and downgrades

5.60 version 0.5.0

• Include full R installation with lme4 package in Windows installer

• Added Analysis tab for application of linear mixed-effects models (#15)

• Allow individual polygon filters for each scatter plot

• Bugfix: Changing filters did not update statistics tab (#24)
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5.61 version 0.4.9

• Bugfix: statistics panel head was in wrong order

• Allow to fix contour plot scaling (#9)

• Ordered parameters in control panels

5.62 version 0.4.8

• New statistics tab (#6)

• Minor improvements of GUI

• Update from dclab: errors when using MV KDE (#20)

5.63 version 0.4.7

• Fix loading of sessions (#17)

5.64 version 0.4.6

• Limit number of events for data analysis (#11)

• Automatically set number of events for multiple data sets (#11)

• Display number of used events on plots (#10)
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CHAPTER 7

Imprint/Impressum

7.1 Imprint and disclaimer

For more information, please refer to the imprint and disclaimer (Impressum und Haftungsausschluss) at https://www.
zellmechanik.com/Imprint.html.

7.2 Privacy policy

This documentation is hosted on https://readthedocs.org/ whose privacy policy applies.
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CHAPTER 8

Indices and tables

• genindex

• modindex

• search
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